Chapter 5

Creating Dress-Up and Hole Features

Learning Objectives

After completing this chapter, you will be able to:

- Create holes using the Hole tool.
- Create fillet features.
- Create chamfer features.
- Add a draft to the faces of the models.
- Create a shell feature.
ADVANCED MODELING TOOLS

In this chapter, you will learn to create some of the placed features that aid in constructing a model. For example, in the previous chapter, you learned to create holes by extruding a circular sketch using the Pocket tool. In this chapter, you will learn to create holes using the Hole tool. You will also learn some other advanced modeling tools, such as fillets, chamfer, draft, shell, and so on.

Creating Hole Features

You can create a simple hole, tapered hole, counterbored hole, countersunk hole, and a counterdrilled hole using the Hole tool. You can also provide threads in the holes. However, you can create only one hole feature at a time using this tool. To create a hole, choose the Hole button from the Sketch-Based Features toolbar; you are prompted to select a face or plane. Select the face or plane from the geometry area on which you need to place the hole; the preview of the hole feature is displayed, along with the Hole Definition dialog box. The Hole Definition dialog box is shown in Figure 5-1.

Creating a Simple Hole

Invoke the Type tab; the Simple option is selected in the drop-down list. Therefore, a simple hole will be created using the current option. Now, invoke the Extension tab. Next, you need to position the center point of the sketch. Choose the Sketcher button in the Positioning Sketch area; the Sketcher workbench is invoked. The center point of the hole is displayed as a sketched point. Locate the point using the Constraint tool and exit the Sketcher workbench. Next, set the feature termination condition and the diameter of the hole using the options in the Extension tab. You can also reverse the direction of the feature creation using the Reverse button.
button in the Direction area. By default, the Normal to surface check box is selected. You can also create a hole along a specified direction by clearing the Normal to surface check box and selecting the direction along which you need to create it.

The drop-down list in the Bottom area is used to specify the shape at the end of the hole. It will not be available if you select the Up To Next or Up To Last termination types. For other termination types, if you select the Flat option, the resulting hole will be flat at the bottom. If you select the V-Bottom option, the bottom of the resulting hole will be of V shape. You can set the angle of the V-shape using the Angle spinner. For the Up To Next or Up To Last termination types, the trimmed bottom is created. Figure 5-2 shows all the three types of the bottom options.

After setting the hole parameters, choose the OK button from the Hole Definition dialog box to create a simple hole. Figure 5-3 shows a base plate, after creating simple holes using the Hole tool.

![Figure 5-2](image1.png)  
**Figure 5-2** Types of bottom termination options for a hole feature

![Figure 5-3](image2.png)  
**Figure 5-3** Base plate with holes created using the Hole tool

**Tip.** While creating a hole using the Hole tool, you can also apply a hole callout to display the hole tolerance. Choose the Hole Tolerance Callout button from the Extension tab of the Hole Definition dialog box; the Limit of Size Definition dialog box is displayed. The preview of the hole tolerance callout is also displayed on the hole feature in the geometry area. Set the value of the hole tolerance using the options in the Limit of Size Definition dialog box and choose the OK button. Now, set the parameters of the hole and exit the Hole Definition dialog box to complete the feature creation. The annotation set is displayed in the specification tree. The information about the hole tolerance callout is displayed in it.

Creating a Threaded Hole

To create the threaded hole, invoke the Thread Definition tab from the Hole Definition dialog box. By default, the Threaded radio button is cleared. Select the Threaded radio button to invoke the options in the Thread Definition tab, as shown in Figure 5-4.
By default, the No Standard option is selected in the Type drop-down list in the Thread Definition area. Therefore, you need to manually specify the parameters to define the thread. Set the value of the thread diameter in the Thread Diameter spinner and the value of the hole diameter in the Hole Diameter spinner. By default, these values are based on the diameter value specified in the extension tab. Set the thread depth and the hole depth in the Thread Depth and the Hole Depth spinners, respectively. Also, set the pitch value in the Pitch spinner. By default, the Right-Threaded radio button is selected. To create a left-hand thread, select the Left-Threaded radio button. After setting the parameters, choose the OK button from the Hole Definition dialog box; a threaded hole will be created. Note that the thread will not be displayed in the hole because only a cosmetic thread is added to the hole feature. When you generate the drawing view, the thread convention will be displayed in it. You will learn more about generating drawing views in later chapters.

To create standard threaded holes, choose the Metric Thin Pitch or Metric Thick Pitch option from the Type drop-down list in the Thread Definition area. You can select the thread standard from the Thread Description drop-down list. In this case, you only need to specify the thread and the hole depth. The hole diameter, thread diameter, and thread pitch is automatically defined on the basis of the selected standard.

Creating a Tapered Hole
To create a tapered hole, invoke the Type tab of the Hole Definition dialog box and select the Tapered option from the drop-down list, as shown in Figure 5-5. The preview of the tapered hole is displayed in the geometry area with the default values. Specify the taper angle in the Angle spinner in the Parameters area, as shown in Figure 5-5.

Note that you cannot define the thread parameters for a tapered hole. After setting all parameters, choose the OK button from the Hole Definition dialog box to create the tapered hole.
Creating Dress-Up and Hole Features

Tip. You can also add user-defined thread standards for creating a threaded hole by choosing the Add button from the Standards area. The File Selection dialog box is displayed. Select the text file, in which the thread standards are saved and choose the Open button from the File Selection dialog box. Now, select the name of the text file from the Type drop-down list in the Thread Definition area. To remove a user defined standard, choose the Remove button from the Standards area; the Standard Threads dialog box is displayed. Select the standard to be removed and choose the OK button.

Creating a Counterbored Hole

A counterbore hole is a stepped hole and has two diameters, a bigger diameter and a smaller diameter. The bigger diameter is called the counterbore diameter and the smaller diameter is called the hole diameter. This hole type requires you to specify two depths, counterbore depth and hole depth. The counterbore depth is the depth up to which the bigger diameter will be defined. The hole depth is the total depth of the hole, including the counterbore depth. Figure 5-6 shows the sectional view of a counterbore hole. Figure 5-7 shows a base plate with counterbored holes.

To create a counterbored hole, select the Counterbored option from the drop-down list in the Type tab of the Hole Definition dialog box, as shown in Figure 5-8. The preview of the counterbored hole is displayed in the geometry area. You can set the value of the counter diameter using the Diameter spinner in the Parameters area. Set the value of the counter depth using the Depth spinner. You can set the diameter and depth of the hole using the options in the Extension tab.

You will notice that the Extreme radio button is selected in the Anchor Point area of the Type tab. If you select the Middle radio button, the bottom face of the counter will be placed on the selected placement plane. This is also the top face of the bore of the hole. You can also
define the thread parameters for a counterbored hole. After setting the parameters, choose the OK button from the Hole Definition dialog box.

**Creating a Countersunk Hole**

A countersunk hole also has two diameters, but the transition between the bigger diameter and the smaller diameter is in the form of a tapered cone. In this hole type, you need to define the countersunk diameter, hole diameter, depth of the hole, and the countersink angle. Figure 5-9 shows the sectional view of a countersunk hole. Figure 5-10 shows the spacer plates after adding the countersunk holes.

To create a countersunk hole, select the Countersunk option from the drop-down list in the Type tab, as shown in Figure 5-11. Its preview is displayed in the geometry area.
Creating a Counterdrilled Hole

A counterdrilled hole is a combination of a counterbored and a countersunk hole. This hole
type has two diameters and the transition between the bigger diameter and the smaller diameter, after the counterbore depth, is in the form of a tapered cone, refer to Figure 5-12. You will have to define the counterbore diameter, hole diameter, depth of counterbore, depth of the hole, and countersink angle. Figure 5-12 shows the sectional view of a counterdrilled hole. Figure 5-13 shows the spacer plates with the counterdrilled holes.

To create a counterdrilled hole, select the Counterdrilled option from the drop-down list in the Type tab; its preview is displayed in the geometry area. Figure 5-14 shows the Hole Definition dialog box, after selecting the Counterdrilled option from the drop-down list. You need to set the value of the diameter of the counter using the Diameter spinner, and the value of its depth using the Depth spinner. Next, you need to set the value of the drill angle in the Angle spinner. You can also specify the thread parameters while creating a counterdrilled hole. After specifying all parameters, choose the OK button from the Hole Definition dialog box.
Creating Dress-Up and Hole Features

Creating Fillets

A fillet is generally provided to reduce the stress concentration in the model. The Part workbench of CATIA V5 provides you with the tools to fillet the sharp edges of the models. You can create simple edge fillets, variable radius fillets, face to face fillets, and tritangent fillets using the tools in the Part mode of CATIA V5. Choose the black arrow on the right of the Edge Fillet button in the Dress-Up Features toolbar; the Fillets toolbar is invoked, as is shown in Figure 5-15.

The procedure of creating various types of fillets is discussed next.

Creating an Edge Fillet

Menu: Insert > Dress-Up Features > Edge Fillet
Toolbar: Dress-Up Features > Fillets > Edge Fillet

To create an edge fillet, choose the Edge Fillet button from the Fillets toolbar; the Edge Fillet Definition dialog box is displayed, as shown in Figure 5-16.

On invoking the Edge Fillet Definition dialog box, you will be prompted to select an edge or a face. Select the edge that you need to fillet; the number of the selected edges will be displayed in the Object(s) to fillet selection area. Note that the default radius value will be displayed only on the first selected edge. Set the value of the fillet radius using the Radius spinner and choose the OK button from the Edge Fillet Definition dialog box. Figure 5-17 shows the edge selected to be filleted. Figure 5-18 shows the resulting filleted edge.
Figure 5-19 shows the face selected to be filleted and Figure 5-20 shows the resulting filleted face.

Figure 5-17 Edge selected to be filleted

Figure 5-18 Resulting edge fillet

Figure 5-19 Face to be selected

Figure 5-20 Resulting fillet

The options in the **Edge Fillet Definition** dialog box, for creating advance edge fillets, are discussed next.
Managing Selected Entities
With the recent releases, a new option has been introduced to manage the entities in the current selection set. To do so, choose the **Selection Filter** button on the right of the **Object(s) to fillet** selection area; the **Fillet objects** dialog box is displayed. All the selected entities are listed in this dialog box. The **Remove** button in this dialog box is used to remove an entity from the current selection set. The **Replace** button is used to replace an entity from the current selection set with another entity from the model.

Managing the Fillet Propagation
While filleting edges, you can manage the propagation of the fillet. By default, the **Tangency** option is selected in the **Propagation** drop-down list. Therefore, the edges tangent to the selected edge will also be selected and filleted. If you select the **Minimal** option from the **Propagation** drop-down list, only the selected edge will be filleted. Figure 5-21 shows the edge to be filleted. Figure 5-22 shows the edge filleted using the **Tangent** option and Figure 5-23 shows the edge filleted using the **Minimal** option.
Trimming the Overlapping Fillets
You can also use the options in the Fillet tool to trim the intersecting surfaces. Consider the case of the model shown in Figure 5-24. Using the Fillet tool, three edges of the model are filleted. If you select the Trim ribbons check box in the Edge Fillet Definition dialog box, the intersecting surfaces created as a result of the fillet will be trimmed. Figure 5-25 shows the resulting fillet after selecting the Trim ribbons check box.

![Figure 5-24](image1.png) Fillet with the Trim ribbons check box cleared

![Figure 5-25](image2.png) Fillet with the Trim ribbons check box selected

Selecting the Edges to Keep
Sometimes while filleting, some of the edges get distorted in order to accommodate the fillet radius, as shown in Figure 5-26. In this model, the bottom edge of the elliptical extruded feature is filleted. The inclined edges are distorted in order to accommodate the fillet radius. To avoid this distortion, choose the More button from the Edge Fillet Definition dialog box; the Edge Fillet Definition dialog box expands. Click once in the Edge(s) to keep selection area and select the distorted edges. Now, choose the OK button from the Edge Fillet Definition dialog box. The edges will not be distorted, as shown in Figure 5-27.

![Figure 5-26](image3.png) Edges distorted to accommodate the fillet radius

![Figure 5-27](image4.png) The model after selecting the edges to be kept
Creating Dress-Up and Hole Features

Note
If the fillet radius is too large to retain the edges, the Update Diagnosis dialog box is displayed. You need to reduce the fillet radius to create the fillet.

Setting the Limits of the Fillet
You can also set the limits of the fillet along the selected edge up to which the fillet will be created. Select the edge or edges to be filleted and set the value of the radius. Now, expand the Edge Fillet Definition dialog box using the More button. Click once in the Limiting element(s) selection area and select the plane up to which you need to create the fillet. An arrow that is displayed in the geometry area defines the direction of the fillet creation. You can flip the direction by clicking on the arrow in the preview of the fillet. You can also create a point or plane within the Fillet tool to define the limit of the fillet. To create a point or plane within the Edge Fillet tool, right-click in the Limiting element(s) selection area; a contextual menu is displayed. Define the limit using the options in the contextual menu. Figure 5-28 shows the edge to be filleted and the limiting element to be selected. Figure 5-29 shows the resulting fillet.

Note
Instead of selecting or creating a limiting element, you can also specify the limit of a fillet by directly selecting points on the edge to be filleted. To define the limits using this method, select the edge to fillet and define the fillet radius. Now, expand the dialog box and click once in the Limiting element(s) selection area. Click on the selected edge where you need to define the limit of the fillet; a blue circle is displayed on the current selection. The arrow defining the direction of the fillet creation is also displayed. If you have selected two elements to limit the fillet, you need to make sure that the arrows of both the limits point in the opposite directions. You can flip the direction of arrows by clicking on them. Figure 5-30 shows the fillet after specifying two limit elements. In this figure, the arrows of both the limits point toward the midpoint of the edge.

Setback Fillet by Blending the Corners
The setback fillet is created where three or more than three edges are merged into a vertex. This fillet type is used to smoothly blend the transition surfaces generated from the edges to
the fillet vertex. This smooth transition is created between all the selected edges and the selected vertex for the setback type of fillet. To create this fillet type, select the edges that you need to fillet and then set the value of the fillet radius. Now, expand the **Edge Fillet Definition** dialog box using the **More** button. Choose the **Blend corner(s)** button from the **Edge Fillet Definition** dialog box. The vertex formed by merging the selected edges is selected and the **Corner.1** callout is displayed attached to the vertex. You will notice that individual setback dimensions are also attached to the selected edges. Select any one of the dimensions and set its value in the **Setback distance** spinner. Similarly, set the setback distance for the other edges. Figure 5-31 shows the edges selected to be filleted. Figure 5-32 shows the preview of the setback fillet after setting the setback distance. Figure 5-33 shows the resulting setback fillet.

**Note**

*Make sure the setback distance is equal to or greater than the fillet radius. Else, the fillet will not be created.*
Creating Variable Radius Fillets

You can create a fillet by specifying different radii along the length of the selected edge using the **Variable Radius Fillet** tool. The transition of the fillet can be smooth or straight, depending upon the option you select. To create a variable radius fillet, choose the **Variable Radius Fillet** button from the **Fillets** toolbar; the **Variable Radius Fillet Definition** dialog box is displayed. Figure 5-34 shows the expanded form of this dialog box.

Select the edge that you need to fillet; two radius callouts are attached to the endpoints of the selected edge. You can also select multiple edges for applying the fillet and use the **Selection Filter** button in the right of the **Edge(s) to fillet** selection area to filter the selection. Next, select one of the radius callouts and set the value of the radius in the **Radius** spinner. Similarly, select the other callout and set the value of the second radius in the **Radius** spinner. Now, choose the **OK** button from the **Variable Radius Fillet Definition** dialog box. The model, after creating the variable radius fillet, is shown in Figure 5-35.
You can also define additional control points on the selected edge. To do so, click anywhere on the edge; a callout is attached to the specified point. You can double-click on the callout value to modify the fillet radius. You can create as many control points as you need by repeating this procedure. Figure 5-36 shows a variable radius fillet after specifying the radii at additional control points.

You can also manage the transition of the variable radius fillet. By default, the **Cubic** option is selected in the **Variation** drop-down list of the **Variable Radius Fillet Definition** dialog box. This option will result in the smooth transition of the fillet surface. If you select the **Linear** option from the **Variation** drop-down list, it will result in the straight transition of the fillet surface. Figure 5-37 shows the variable radius fillet with the **Cubic** option selected and Figure 5-38 shows the variable radius fillet with the **Linear** option selected.
Creating Face-Face Fillets

The **Face-Face Fillet** tool is used to fillet the selected faces of the model. To create a face fillet, choose the **Face-Face Fillet** button from the Fillets toolbar; the **Face-Face Fillet Definition** dialog box is displayed, as shown in Figure 5-39.

![Face-Face Fillet Definition dialog box](image)

Select the first and second faces from the geometry area and then set the value of the radius of the fillet using the **Radius** spinner. Choose the **Preview** button from the **Face-Face Fillet Definition** dialog box. If the **Feature Definition Error** window is displayed, you need to modify the value of the fillet radius after exiting this window. Figure 5-40 shows the faces to be selected to create the face-face fillet and Figure 5-41 shows the resulting face-face fillet.

![Faces to be selected](image)  ![Resulting face-face fillet](image)

Creating Tritangent Fillets

The **Tritangent Fillet** tool is used to create the fillet feature that is tangent to three selected faces. To create a tritangent fillet, choose the **Tritangent Fillet** button from the Fillets toolbar; the **Tritangent Fillet Definition** dialog box is displayed, as shown in Figure 5-42.
You are prompted to select the first face. Upon doing so, you are prompted to select the second face. Next, you are prompted to select the face to be removed. Select the face from the geometry area, refer to Figure 5-43. Choose the Preview button from the Tritangent Fillet Definition dialog box to preview the tritangent fillet. Figure 5-43 shows the faces to be selected and Figure 5-44 shows the resulting tritangent fillet.

Creating Chamfers

Chamfering is defined as a process in which the sharp edges are beveled in order to reduce the stress concentration in the model. This process also eliminates the sharp edges that are not desirable. To chamfer the edges of the model, choose the Chamfer button from the Dress-Up Features toolbar; the Chamfer Definition dialog box will be displayed, as shown in Figure 5-45.

You are prompted to specify the required data to define the chamfer. First, you need to select the edges or faces that are to be chamfered. If you select a face to chamfer, all edges of that face are chamfered. The numbers of the selected elements are displayed in the Object(s) to chamfer selection area. You can also use the Selection Filter button on the right of the Object(s) to chamfer selection area to filter the selection.

You will notice that the Length1/Angle option is selected by default in the Mode drop-down list. Therefore, you need to define the values of the length of the chamfer and its angle in the
Creating Dress-Up and Hole Features

Figure 5-45 The Chamfer Definition dialog box

Length 1 and Angle spinners, respectively. On selecting the Length1/Length2 option from the Mode drop-down list, you need to define the value of the first and second lengths of the chamfer in the Length 1 and the Length 2 spinners, respectively.

To chamfer all edges tangent to the selected edges, select the Tangency option from the Propagation drop-down list. To chamfer only the selected edge, select the Minimal option from the Propagation drop-down list.

The Reverse check box is selected to flip the direction of the first length. Figure 5-46 shows the edge selected to be chamfered and Figure 5-47 shows the resulting chamfer.

Adding a Draft to the Faces of the Model

A draft is defined as the process of adding a taper angle to the faces of the model. Adding a draft to the faces of the model is one of the most important operations, especially while creating the components that need to be cast, molded, or formed. Draft angles enable components to be easily ejected from the die. The Part workbench of CATIA V5 provides you with various tools to draft faces of the model. These tools are discussed next.
Adding a Simple Draft

The Draft Angle tool is the most widely used tool to add a draft to the faces of the model. To add a draft, choose the Draft Angle button from the Drafts toolbar; the Draft Definition dialog box will be displayed, as shown in Figure 5-48. Also, an arrow will be displayed at the origin will point in the default pull direction.

Select the faces from the geometry area on which you need to add the draft angle; the selected faces will be displayed in brown. The faces tangent to the selected face are automatically selected. You can also filter the selection using the Selection Filter button on the right of the Face(s) to draft selection area. Next, you need to define a neutral plane. Click once in the Selection selection area in the Neutral Element area and then select a face or plane that will be defined as the neutral plane. By default, the None option is selected in the Propagation drop-down list. If you select the Smooth option, the faces tangent to the selected face are also selected automatically as the neutral element. Now, set the value of the draft angle in the Angle spinner and choose the OK button. Figure 5-49 shows the faces to be drafted and the face to be selected as the neutral plane. Figure 5-50 shows the resulting drafted faces.

Figure 5-51 shows the xy plane to be selected as the neutral plane and Figure 5-52 shows the resulting drafted faces.

Tip. To add a draft to all faces that are in contact with the neutral face, instead of selecting all the faces one by one, select the Selection by neutral face check box and select the neutral face.
Defining the Parting Element while Adding Drafts to the Faces

You can also define the parting elements while drafting the faces of the model. To define it, choose the More button from the Draft Definition dialog box to expand the dialog box. If you choose the Parting = Neutral check box from the Parting Element area, the neutral element is selected as the parting element. Consider the case shown in Figure 5-51, in which a plane passing through the center of the model is selected as the neutral plane. Figure 5-53 shows the faces drafted with the Parting = Neutral check box selected. When you select the Parting = Neutral check box, the Draft both sides check box is invoked. If you select this check box, the draft is added to both sides of the parting element, refer to Figure 5-54.

You can also select a user-defined parting element other than the neutral plane. To select a user-defined parting element, select the Define parting element check box from the Parting Element area and select the parting element from the geometry area. Now, set the other parameters of the draft and choose the OK button from the Draft Definition dialog box. Figure 5-55 shows the faces to be drafted, neutral plane, and parting plane and Figure 5-56 shows the resulting drafted faces.
You can also define the limit elements while adding a draft to the faces of the model. To do so, click once in the Limiting Element(s) selection area and select the limiting elements from the geometry area. You need to make sure that if you specify two limiting elements, the feature is created in the opposite directions. Figure 5-57 shows the limiting elements to be selected and Figure 5-58 shows the resulting draft feature.

**Tip.** By default, the pulling direction is selected along the Z axis direction. You can also specify a user-defined pulling direction by clicking once in the Pulling Direction selection area and then selecting the pulling direction from the geometry area.

**Adding Drafts using the Reflect Line**

**Toolbar:** Dress-Up Features > Drafts > Draft Reflect Line

The Draft Reflect Line tool is used to create the draft feature using the silhouette lines of the selected curved face as the neutral element. To create this type of draft feature,
choose the Draft Reflect Line button from the Drafts toolbar; the Draft Reflect Line Definition dialog box is displayed, as shown in Figure 5-59.

Select a curved face from the geometry area. You can also filter the selection using the Filter Selection button. The faces tangent to the selected face are also selected automatically. You will notice that a pink color sketch is created along the silhouette of the selected face. Now, expand the dialog box using the More button and select the Define parting element check box. You are prompted to select the parting element. Select the plane or planar face that will be used as the parting element. Set the value of the draft angle and choose the OK button from the Draft Reflect Line Definition dialog box. Figure 5-60 shows the face to be drafted and the plane to be selected as the parting element. Figure 5-61 shows the resulting drafted feature.
Adding a Variable Angle Draft

To create a variable angle draft, choose the Variable Angle Draft button from the Drafts toolbar. The Draft Definition dialog box is displayed, as shown in Figure 5-62.

![Figure 5-62 The Draft Definition dialog box](image)

Select the face to add the draft. You can select only one face while adding a draft using this tool. Define the neutral element by selecting a plane or face. You will notice that two angular dimensions are displayed attached to the end points of the selected face. One by one, select both the angles and set their values using the Angle spinner. You can also filter the selections using the Selection Filter button. Figure 5-63 shows the references to be selected and Figure 5-64 shows the resulting face after adding the draft.

![Figure 5-63 References to be selected](image)  ![Figure 5-64 Face after adding the draft](image)

You can also define additional points to specify other variable angles. Note that the point can...
Creating Dress-Up and Hole Features

only be selected on the edge from which the angle is measured. To define an additional point, click anywhere on the edge from where the angle is measured. If you want to define points whose distances need to be controlled, right-click in the Points selection area and invoke the contextual menu. Create additional points and then set the draft angle by using the options in the contextual menu.

Creating a Shell Feature

The Shell tool is used to scoop out the material from the model and remove the selected faces, thereby resulting in a thin walled structure. To create a shell feature, choose the Shell button from the Dress-Up Features toolbar; the Shell Definition dialog box is displayed, as shown in Figure 5-65. The Shell tool is used to scoop out the material from the model and remove the selected faces, thereby resulting in a thin walled structure. To create a shell feature, choose the Shell button from the Dress-Up Features toolbar; the Shell Definition dialog box is displayed, as shown in Figure 5-65.

Next, you need to select the face or faces to be removed. Select them from the geometry area. The faces tangent to the selected face are selected automatically. You can filter the selection using the Selection Filter button. Now, set the value of the wall thickness in the Default inside thickness spinner in the Shell Definition dialog box. You can also define the outside thickness of the shell using the Default outside thickness spinner. Now, choose the OK button from the Shell Definition dialog box. Figure 5-66 shows the faces to be removed and Figure 5-67 shows the resulting shelled model. If you do not select any of the faces to be removed, the resulting shelled model will be a hollow model with a specified wall thickness.

Figure 5-65 The Shell Definition dialog box

Figure 5-66 Faces to be selected for removal

Figure 5-67 Resulting shelled model
Creating a Multithickness Shell
You can also define different shell thickness values for the faces of the shell feature. To create a multithickness shell feature, first select the faces to be removed and then specify the default inside or outside thickness of the shell. Now, click once in the Other thickness faces selection area and then select the faces on which you need to define the different shell thickness value. The faces tangent to the selected face are selected automatically. The selected faces will be highlighted in brown and the shell thickness dimensions will be attached to them. Select the thickness value of one of the highlighted faces from the geometry area; the selected value is displayed in the Default inside thickness spinner in the Shell Definition dialog box. Modify the thickness value and repeat the process for the remaining highlighted faces. After setting all the shell thickness values, choose the OK button from the Shell Definition dialog box. Figure 5-68 shows the face to be removed and the faces to define the different shell thicknesses and Figure 5-69 shows the resulting shelled model.

![Figure 5-68](image1)
![Figure 5-69](image2)

TUTORIALS

Tutorial 1
In this tutorial, you will create the model of the nozzle of a vacuum cleaner shown in Figure 5-70. Its views and dimensions are shown in Figure 5-71.

(Expected time: 45 min)

The following steps are required to complete this tutorial:

a. Start a new file in the Part workbench and create the base feature of the model by extruding the sketch along the selected direction, refer to Figures 5-72 through 5-76.

b. Create the second feature of the model by extruding a sketch using the Drafted Fillet Pad tool, refer to Figures 5-77 and 5-78.

c. Create the third feature of the model, which is a cut feature. It will be used to remove the unwanted portion of the second feature, refer to Figures 5-79 and 5-80.

d. Apply fillets to all edges of the model, refer to Figures 5-81 through 5-84.

e. Shell the model using the Shell tool, refer to Figures 5-85 and 5-86.
Creating the Base Feature of the Model

The base feature of this model is created by first creating a plane at an angle of 26-degree and then extruding a sketch drawn on that plane. The sketch will be extruded along a selected direction. In this model, you will learn a technique to create the reference sketch first and then follow it to create the model. Therefore, you will first draw the reference sketch.
1. Start a new file in the **Part** workbench. Select the zx plane and invoke the **Sketcher** workbench.

2. Draw the sketch, as shown in Figure 5-72, and then exit the **Sketcher** workbench.

3. Select the yz plane and invoke the **Sketcher** workbench. Place a point colinear to the X-axis at any distance, as shown in Figure 5-73. Exit the **Sketcher** workbench.

After drawing the reference sketch and placing the point, you need to create a reference plane to create the base feature.

4. Create a plane by selecting three points, as shown in Figure 5-74.

5. Invoke the **Sketcher** workbench after selecting the newly created plane as the sketching plane and draw the sketch, as shown in Figure 5-75.

6. Exit the **Sketcher** workbench. Choose the **Pad** button from the **Sketch-Based Features** toolbar; the **Pad Definition** dialog box is displayed.
7. Set the value of the Length spinner to 28. The preview of the extruded feature is displayed in the geometry area. If the sketch is extruded in the downward direction, then choose the Reverse Direction button to flip the direction of the feature creation.

8. Now, choose the More button to expand the Pad Definition dialog box.

9. Clear the Normal to profile check box provided in the Direction area and select the xy plane as the direction of extrusion.

10. Choose the OK button from the Pad Definition dialog box to complete the feature creation. The model, after creating the base feature, is shown in Figure 5-76.

![Figure 5-76 Model after creating the base feature](image)

**Creating the Second Feature**

The second feature of this model is a drafted extrude feature created using the Drafted Filleted Pad tool. In this feature, you will extrude the sketch drawn on a plane created normal to the right line of the reference sketch.

1. Invoke the Plane tool and select the Normal to curve option from the Plane type drop-down list.

2. Now, select the right line of the reference sketch as the curve and then select the upper endpoint of the same line as the point on which the plane will be created. The preview of the plane is displayed in the geometry area.

3. Choose the OK button from the Plane Definition dialog box.

4. Use the newly created plane to invoke the Sketcher workbench and draw the sketch, as shown in Figure 5-77.

5. Exit the Sketcher workbench and invoke the Drafted Filleted Pad tool.
6. Set the value of the **Length** spinner to **85** and select the newly created plane from the geometry area as the second limit.

7. Set the value of the draft angle in the **Angle** spinner to **2deg**. Choose the **Reverse Direction** button to flip the direction of the feature creation.

8. Clear all the radio buttons in the **Fillets** area and choose the **OK** button from the **Drafted Fillet Pad Definition** dialog box. The model, after creating the second feature, is shown in Figure 5-78.

![Figure 5-77 Sketch for the second feature](image1)

![Figure 5-78 Resulting second feature](image2)

Next, you need to create the third feature of the model to remove the unwanted portion of the second feature.

9. Select the **zx plane** and invoke the **Sketcher** workbench. Draw the open sketch, as shown in Figure 5-79, and exit the **Sketcher** workbench.

10. Extrude the sketch using the **Pocket** tool up to the last on both sides of the sketch. You may have to reverse the direction of material removal.

11. Using the **Hide/Show** tool, hide Sketch1, Sketch2, Plane1, and Plane2. The model, after creating the third feature, is shown in Figure 5-80.

### Filleting the Edges of the Model

Next, you need to fillet two sets of edges of the model. You need to apply the fillet feature twice because the two sets of edges need different fillet radii. First you will fillet the set of edges that needs the fillet radius of **12**.

1. Double-click on the **Edge Fillet** button in the **Dress-Up Features** toolbar; the **Edge Fillet Definition** dialog box is displayed.

2. Select the edges, as shown Figure 5-81, and set the value of the **Radius** spinner to **12**.
3. Choose the OK button from the Edge Fillet Definition dialog box. The model, after creating the first set of fillet, is shown in Figure 5-82.

4. Select all edges of the model, except the edges that are shown in Figure 5-83.

5. Set the value of the Radius spinner to 3 and choose the OK button from the Edge Fillet Definition dialog box. Cancel this dialog box when it is displayed again. The model, after applying the fillet to the second set of edges, is shown in Figure 5-84.

**Creating the Shell Feature**

Lastly, you need to create the shell feature. The shell feature will also be used to remove the end faces of the model, leaving behind a thin walled structure.
1. Choose the **Shell** button from the **Dress-Up Features** toolbar; the **Shell Definition** dialog box is displayed.

2. Select the faces to be removed, as shown in Figure 5-85.

3. Set the value of the **Default inside thickness** spinner to 2 and choose the **OK** button from the **Shell Definition** dialog box. The final model, after creating the shell feature, is shown in Figure 5-86.

**Saving and Closing the Files**

1. Choose the **Save** button from the **Standard** toolbar to invoke the **Save As** dialog box. Create the c05 folder inside the CATIA folder.

2. Enter the name of the file as **c05tut1** in the **File name** edit box and choose the **Save** button. The file will be saved in the |My Documents|CATIA|c05 folder.

3. Close the part file by choosing **File > Close** from the menu bar.
Tutorial 2

In this tutorial, you will create the model of the plastic cover shown in Figure 5-87. Its views and dimensions are shown in Figure 5-88. (Expected time: 30 min)

The following steps are required to complete this tutorial:

a. Create the base feature of the model by extruding the sketch drawn on the zx plane equally to both sides of the sketch plane, refer to Figures 5-89 and 5-90.

b. Create the second feature by extruding the sketch drawn on a plane created at an offset distance from the xy plane, refer to Figures 5-91 and 5-92.
Creating the Base Feature of the Model

First, you need to create the base feature of the model by extruding the sketch drawn on the zx plane. The sketch will be extruded equally to both sides of the sketching plane using the **Mirrored extent** option.

1. Start a new part file. Select the zx plane as the sketching plane and invoke the **Sketcher** workbench.
2. Draw the sketch, as shown in Figure 5-89, and exit the **Sketcher** workbench.
3. Invoke the **Pad Definition** dialog box and set the value of the **Length** spinner to 125.
4. Select the **Mirrored extent** check box and choose the **OK** button from the **Pad Definition** dialog box. The model, after creating the base feature, is shown in Figure 5-90.

![](image)

**Figure 5-89** Sketch of the base feature

**Figure 5-90** The model after creating the base feature

Creating the Second Feature

The second feature of the model will be created by extruding the sketch drawn on a plane created at an offset distance of 14 from the xy plane.

1. Create a plane at an offset distance of 14 mm from the xy plane.
2. Invoke the **Sketcher** workbench using the newly created plane as the sketching plane.
3. Draw the sketch, as shown in Figure 5-91, and exit the **Sketcher** workbench.
4. Invoke the Pad Definition dialog box and choose the Reverse Direction button.

5. Select the Up to next option from the Type drop-down list and exit the Pad Definition dialog box. The model, after creating the second feature, is shown in Figure 5-92.

![Figure 5-91 Sketch of the second feature](image1)

![Figure 5-92 The model after creating the second feature](image2)

**Adding a Draft to the Faces of the Model**

Next, you need to add a draft to the faces of the model. The draft angle is added to make sure that the component is smoothly ejected from the die. The draft angle is one of the most important aspects of designing the components to be formed, molded, or cast.

1. Choose the Draft Angle button from the Dress-Up Features toolbar; the Draft Definition dialog box is displayed and you are prompted to select the faces to be drafted.

2. Select all the vertical faces of the base feature and the second feature from the geometry area.

3. Click once in the Selection selection area in the Neutral Element area and select the bottom face of the base feature as the neutral element. Make sure that the pulling direction is in the upward direction.

4. Set the value of the Angle spinner to 3 and choose the OK button from the Draft Definition dialog box. The model, after creating the draft feature, is shown in Figure 5-93.

**Filleting the Edges of the Model**

Next, you need to fillet the edges of the model. In this model, you need to fillet three separate set of edges using the Edge Fillet tool.

1. Choose the Edge Fillet button from the Dress-Up Features toolbar; the Edge Fillet Definition dialog box is displayed.
2. Select the edges shown in Figure 5-94 and set the value of the Radius spinner to 3.

3. Choose the OK button from the Edge Fillet Definition dialog box. The model, after filleting the first set of edges, is shown in Figure 5-95.

4. Invoke the Edge Fillet Definition dialog box again to fillet the second set of edges.

5. Select the edge shown in Figure 5-96 and set the value of the Radius spinner to 1.

6. Choose the OK button from the Edge Fillet Definition dialog box. The model, after filleting the second set of edges, is shown in Figure 5-97.

7. Invoke the Edge Fillet Definition dialog box again to fillet the third set of edges.

8. Select all the edges of the model, except the edges shown in Figure 5-98, and set the value of the Radius spinner to 5.
9. Choose the OK button from the **Edge Fillet Definition** dialog box. The resulting filleted model is shown in Figure 5-99.

---

**Creating the Shell Feature**

Finally, you need to shell the model and remove its bottom face.

It is always recommended to shell the model after adding the draft angle and the fillet feature to maintain the draft angle and fillet curvature on the inside walls of the shelled model.

1. Choose the **Shell** button from the **Dress-Up Features** toolbar; the **Shell Definition** dialog box is displayed.

2. Select the face to be removed, as shown in Figure 5-100, and set the value of the **Default inside thickness** to 2.
3. Choose the OK button from the Shell Definition dialog box. The rotated view of the model, after adding the shell feature, is shown in Figure 5-101.

![Face to be removed](image1)

**Figure 5-100** Face to be removed

![Resulting shelled model](image2)

**Figure 5-101** Resulting shelled model

4. Use the Pocket tool to create the two pocket features. The final model, after creating the other two features, is shown in Figure 5-102.

![Final model after creating the remaining features](image3)

**Figure 5-102** Final model after creating the remaining features

### Saving and Closing the Files

1. Choose the Save button from the Standard toolbar to invoke the Save As dialog box.

2. Enter the name of the file as c05tut2 in the File name edit box and choose the Save button. The file will be saved in the |My Documents|CATIA|c05 folder.

3. Close the part file by choosing File > Close from the menu bar.
SELF-EVALUATION TEST
Answer the following questions and then compare your answers with those given at the end of this chapter:

1. While creating a hole using the **Hole** tool, you can also apply a hole callout to display the hole tolerance. (T/F)

2. You can create a countersunk hole using the **Hole** tool. (T/F)

3. You can also add user-defined thread standards for creating a threaded hole. (T/F)

4. You cannot set the limits of the fillet along the selected edge. (T/F)

5. Instead of selecting or creating a limiting element, you can also specify the limit of the fillet by directly selecting points on the edge to fillet. (T/F)

6. The ________ tool is used to create the draft feature using the silhouette lines of the selected curved face as the neutral element.

7. The ________ tool is used to scoop out the material from the model and remove the selected faces, resulting in a thin walled structure.

8. By default, the pulling direction is selected in the ________ axis of the selected neutral face while creating the draft feature.

9. The ________ tool is used to apply a fillet between the selected faces of the model.

10. ________ is defined as a process in which the sharp edges are bevelled in order to reduce the area of stress concentration.

REVIEW QUESTIONS
Answer the following questions:

1. You can select the ________ option in the **Edge Fillet Definition** dialog box to trim the intersecting surfaces.

2. The ________ fillet is created when three or more than three edges are merged into a vertex.

3. You cannot create a counterdrilled hole using the **Hole** tool. (T/F)

4. You cannot define a different shell thickness value to the faces of the model while creating the shell feature. (T/F)
5. To create an edge fillet, choose the **Face-Face Fillet** button from the **Fillets** toolbar. (T/F)

6. Which tool is used to taper the faces of the model?
   - (a) Draft Angle
   - (c) Chamfer
   - (b) Edge Fillet
   - (d) Shell

7. When you define **Up To Plane** or **Up To Surface** as the feature termination condition of a **Hole** feature, then which option is selected automatically in the drop-down list in the **Bottom** area of the **Extension** tab?
   - (a) Extend
   - (c) Trimmed
   - (b) Edge Fillet
   - (d) Tangent

8. Which tool is used to create a fillet feature tangent to three faces?
   - (a) Face-Face Fillet
   - (c) Tritangent Fillet
   - (b) Variable Radius Fillet
   - (d) Edge Fillet

9. Which tab of the **Hole Definition** dialog box is used to define the parameters to create a tapped hole?
   - (a) Extension
   - (c) Hole
   - (b) Type
   - (d) Thread Definition

10. Which tool is used to create a variable angle draft?
    - (a) Draft Angle
    - (c) Face-Face Fillet
    - (b) Draft Reflect Line
    - (d) None of these

**EXERCISES**

**Exercise 1**

Create the model of the Clutch Lever shown in Figure 5-103. Its views and dimensions are shown in Figure 5-104.  
(Expected time: 30 min)
Creating Dress-Up and Hole Features

Figure 5-103 Model of the Clutch Lever for Exercise 1

Figure 5-104 Views and dimensions of the Clutch Lever for Exercise 1
Exercise 2

Create the model of the Clamp Stop shown in Figure 5-105. Its views and dimensions are shown in Figure 5-106.

(Expected time: 1 hr)

Figure 5-105 Model of the Clamp Stop for Exercise 2

Answers to Self-Evaluation Test